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Unlock Microsoft Office File

A potentially dangerous macro has been
blocked

Macros can add a lot of functionality to Office, but they are often used by people with bad
intentions to distribute malware to unsuspecting victims.

Macros aren't required for everyday use like reading or editing a document in Word or using Excel
workbooks. In most cases you can do everything you need to do in Office without allowing macros
to run.

Note: If you're an IT pro looking to configure this setting, or if you just want more advanced

technical details, see Macros from the internet will be blocked by default in Office.

What should | do now?

Still wondering if you should proceed?

e [JWere you expecting to receive a file with macros? Never open a file attachment
you weren't expecting, even if it appears to come from somebody you trust. Phishing
attacks often appear to come from a person or organization you trust in an effort to get
you to open them.

o (JAre you being encouraged to enable content by a stranger? A common tactic of
attackers is to create some pretense such as cancelling an order or reading a legal
document. They'll have you download a document and try to persuade you to allow
macros to run. No legitimate company will make you open an Excel file to cancel an order
and you don't need macros just to read a document in Word.

o [JAre you being encouraged to enable content by a pop-up message? If you
downloaded the file from a website, you may see pop-ups or other messages encouraging
you to enable active content. Those are also common tactics of attackers and should
make you suspicious that the file is actually unsafe.


https://go.microsoft.com/fwlink/p/?linkid=2185771

If a downloaded file from the internet or a file opened from a network share wants you to allow
macros, and you're not certain what those macros do, you should probably just delete that file.

If you’re sure the file is safe and want to
unblock macros

There are a few different ways to do it, depending on your situation.

Unblock a single file

In most cases you can unblock macros by modifying the properties of the file as follows:

1. Open Windows File Explorer and go to the folder where you saved the file.
2. Right-click the file and choose Properties from the context menu.
3. At the bottom of the General tab, select the Unblock checkbox and selectOK.

In file properties, near the bottom of the General tab, is a Security section with a checkbox for unblc
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How to Fix “The Set of Folders
Cannot Be Opened” Error In
Outlook

‘ = Important Note: Back up your Outlook data before pursuing the solutions below.

Launch Outlook in Safe Mode

Press the Windows and R keys to launch a new Run window. Then type Outlook.exe /safe, and
hit OK.
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If the issue is gone in Safe Mode, most likely, your add-ins are to blame. Go to the next step
and disable your add-ins.

Disable Your Add-Ins

1. Launch Outlook and go to File.

2. Select Options, and click on Add-ins.

3. Click on Manage and hit the Go button.
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https://book.msls.tech/uploads/images/gallery/2023-08/aPNimage.png
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1. Select the add-ins you want to disable and save the changes.

Don’t forget to update your Outlook version. Click on File, select Office Account, and go to Office
Update. Click on Update Options and select Update now to update your email client.
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Recreate Your Email Profile

Some users were able to fix this error by recreating their email profiles.

1. Type regedit in the Windows Search bar and launch the Registry Editor.

2. Then, navigate to
Computer\HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\16.0\Outlook\Profil
es

3. Go ahead and delete all the folders listed under Profiles.

e Note: Depending on your Office version, you may need to navigate to
Computer\HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\15.

4. Relaunch Outlook and recreate your email profile.

5. Go to File, select Account Settings, and click on Manage Profiles.
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6. Then go to Show Profiles and hit the Add button.

7. Enter all the necessary details in the Profile Name box and save the changes.
image.png

Alternatively, if you're not comfortable using the Registry Editor, you can only follow the
steps from 5 to 8 to create a new profile.

If you can’t create a new profile using Outlook, go to Control Panel = Mail -» Show Profiles -
Add.
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Repair Office

Go to Control Panel and select Programs.

Click on Programs and Features and select your Office package.

Hit the Change button and launch the Quick Repair tool.

If the error persists and you still can’t use Outlook properly, run the Online Repair tool as
well.
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Repair Outlook

Go to Settings and select Apps.

Then click on Apps and Features and select Outlook (or Outlook Desktop Integration).
Go to Advanced options and hit the Repair option.
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Alternatively, you can repair the Outlook data file (.pst) file directly.

1. Close Outlook and navigate to Outlook 2016/2019: C:\Program Files (x86)\Microsoft
Office\root\Officel6 or Outlook 2013: C:\Program Files (x86)\Microsoft
Office\Officel5 (depending on your Office version).

2. Locate and run SCANPST.EXE.
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1. Click on Browse to select the Outlook Data File (.pst).
2. Hit the Start button and then select the Repair option.

Run Microsoft’s Support and Recovery Assistant

There's another handy tool that you can use to repair Outlook. The Microsoft Support and Recovery

Assistant can quickly find and repair various Office and Outlook issues. Download the tool from

Microsoft, install it on your computer, and follow the on-screen instructions to repair Outlook.

Reduce Outlook Data Size

Large mailboxes can take an awful lot of time to open. Apart from that, they may also trigger
various errors while loading. Reduce the size of your mailbox and Outlook data files and check if
the error persists.

1. Launch Outlook, click on File, select Tools, and click on Mailbox Cleanup.
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Select the items you want to remove and confirm your choice.

To reduce the size of the data file, empty the Deleted Items folder.

Then click on File, and select Account Settings.

Go to the Data Files tab, and select the file that you want to compact.

Go to Settings and hit the Compact Now option.
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Exchange and Outlook.com users need to click on Settings - Advanced - Outlook Data File
Settings.

Reinstall Outlook


https://support.microsoft.com/en-us/office/about-the-microsoft-support-and-recovery-assistant-e90bb691-c2a7-4697-a94f-88836856c72f
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If you're using the standalone desktop app, uninstall it and restart your computer. Then download
Outlook again (the 64-bit version). If the error persists, go to Control Panel and select Uninstall a
program. Then uninstall your Office package, restart your machine again and reinstall Office.
Check the results.

Conclusion

Microsoft Outlook may sometimes fail to launch with the “The set of folders cannot be opened”
error. To fix it, launch Outlook in Safe Mode and disable your add-ins. Then repair Office and
Outlook, create a new user profile and reinstall the email client. Which of these solutions worked
for you?



How to Filter Email in Outlook
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Is your Outlook inbox so unorganized that you can't find what you're looking for? Fortunately, it's
easy to filter messages into different folders based on email address (sender or receiver), words,
and phrases in any version of Outlook, including Microsoft Outlook 365. We'll show you how to
create rules in Outlook to automatically filter incoming email messages, plus how to sort your
existing emails.

Method 1

Filtering by Email Address

1 Click a message sent to or from an address you want to filter. This opens the message in
the right panel.

e For example, if you want to filter all mail sent from one email address, click an email from
that sender.

e If you want to filter messages sent to one of your email addresses, click a message
addressed to that address.
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2 Click the Home tab. It’s near the top-left corner of the window.
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3 Click Rules. It's in the row of icons near the top of the screen, toward the center.

e If you don't see this option, click the three dots at the far-right corner of the toolbar.
e You can also right-click a message or folder and select Rules
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4 Click Always Move Messages From <sender> or Always Move Messages To <address>.
A list of folders on your account will appear.
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5 Select the folder to which you want these messages filtered. If you don’t see a folder you
want to use, click New to create one, then select it.
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6 Click OK. Future email sent to or from the email address you selected will be moved to the
selected folder upon receipt.
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Method 2

Filtering by Words

1 Click a message containing a word or phrase you want to filter. The word or phrase can
be anywhere in the message, such as the subject, body, or header.
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2 Click the Home tab. It's near the top-left corner of the screen.
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3 Click Rules. It's in the row of icons near the top of the screen, toward the center.

e If you don't see this option, click the three dots at the far-right corner of the toolbar.
e You can also right-click a message or folder and select Rules.
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4 Click Manage Rules & Alerts.
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5 Click New Rule. It's at the top-left corner of the window.
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6 Select Move messages with specific words in the subject to a folder. Even if you don’t
want to filter only words in the subject, select this option for now.
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7 Click Next. A list of options and check boxes will appear.
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8 Remove the check mark from “with specific words in the subject.” You can skip this step
if you only want the filter to look at words in the subject line.
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9 Select the parts of the message where the filter will look for the words. Choose at least
one of these options:

e with specific words in the subject or body
o Example: You want to filter messages with the word “coupon” in either the subject or
the body to a folder called Coupons.
e with specific words in the message header
o Example: You want messages sent through a certain mail server to go straight to the
trash.
e with specific words in the recipient’s address
o Example: You want mail sent to support@yourdomain.com to go to a folder called
Support.
e with specific words in the sender’s address
o Example: You want messages sent from anyone with the word “wiki” in their email
address to a folder called Wiki.
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10 Click Next.
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11 Type the word or phrase and click Add. You can add multiple words and phrases if you
wish.
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12 Click OK. This brings you back to the list of filter conditions.
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13 Click the specified link. It's in the box at the bottom of the window as a part of the phrase
“specified folder.” A list of folders on your email account will appear.
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14 Select the folder you to which you want these messages filtered. If you don’t see a
folder you want to use, click New to create one, then select it.
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15 Click OK.
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16 Click Next. Now you’ll see a list of actions Outlook can take based on the filter you created.
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17 Check the boxes next to what you’d like to happen. Make sure “move it to the specified
folder” (the second option) is checked so the message lands in its folder. The others are optional,
but can be helpful based on your needs.
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18 Click Next.
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19 Enter a name for the filter. This is how it will appear in your list.
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20 Check the box next to “Turn on this rule.” If you'd like, you can also check “Run this now”
so the filter will scan the mail you’'ve already received.
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21 Click Finish. Future incoming messages will now be sorted based on the word or phrase you
entered.
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Method 3

Sorting Your Outlook Inbox

1 Open Microsoft Outlook. It’s usually in the Microsoft Office folder, which you’'ll find in the All
Apps area of the Start menu.

e You'll want to use this method to search or filter all your current email.
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2 Click Filter Email. This is next to a funnel icon in the "Find" grouping of the Home tab.
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3 Select your filter. You can see all the emails marked as unread, has attachments, when they
were received, if they are categorized, flagged or marked important, or based on the "Sent to"
field.
e For example, if you select "Has attachments," you will see a list of emails that have
attachments (even if they are categorized into email folders that aren't the Inbox).
e To clear the filter search, click the x in the search box.[2]
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Windows 11

How to Fix the “User Profile
Service Failed the Sign-in" Error
for Windows

Are you getting the “User Profile Service failed the sign-in” or “User profile cannot be loaded” error
during Windows startup? This message is shown as soon you type your password in the Windows
logon screen, and your default user profile fails to launch. In its place, a corrupt user profile takes
over, changing your lock screen and desktop background. Because the proper profile wouldn't load,
you're unable to log in to your system. If you’'re facing this frustrating issue, one of our solutions
below will resolve it immediately.

Causes of “User Profile Service Faliled
the Sign-in” Error

There are many reasons you may encounter the “User profile failed the sign-in” error. Variations of
this error include: “User profile cannot be loaded” and “User profile service failed the logon.” If you
get any of these error messages, it means the default Windows user profile has been corrupted,
which can be traced to one or more of the following factors:

e Improper Windows update: User Account Control (UAC) is designed to prevent
unauthorized changes to your Windows device. Any irregular or unfinished updates or a
crash can sometimes corrupt host files that are required for UAC to work properly.

e Partition resizing error: when resizing partitions from Disk Management, those parts
can occasionally get corrupted, leading to an incorrect user profile.

e Antivirus program: if an antivirus program was scanning your system while you tried to

log in, it can abort the correct user profile and launch an incorrect one.

e Improper shutdown and restarts in guest logons: if you did not exit smoothly from a
local account created on your PC, you may encounter a user profile error on a subsequent
login.

Tip: looking to smoothly transfer user profile data to another in Windows? This guide can help.



https://www.maketecheasier.com/best-101-free-computer-software-for-your-daily-use/#anti-virus
https://www.maketecheasier.com/transfer-user-profile-data-to-another-windows/

Solutions for User Profile Service Failed
the Logon Error in Windows

The good thing is that none of the above causes are major concerns. You can easily repair the
corrupted user profile using one of the troubleshooting solutions below.

You should first attempt the first few easy methods. Go for the more intricate and time-consuming
solutions toward the end - only if the easy ones fail to resolve the problem.

1. Restart or Shut Down Windows From
Its Lock Screen

Sometimes you only need a simple restart or shutdown from the lock screen window to fix the
issue.

1. Whether you're inside an administrator or guest logon, use W n + L to exit, and go to the
Windows lock screen.

2. Navigate to the administrator profile (if a guest profile was previously used to log in), and
click the lock screen shutdown/restart options. Make sure you log in as the administrator

during the subsequent startup. We can help if you need to reset your administrator

password.

Logging out of local account on Windows.

Tip: did you know that you can install Windows 11 even on an unsupported PC? Learn how to get

started.

2. Delete a Local User Account In
Windows

If the user profile error is due to improper shutdowns and restarts during a guest logon, you may
want to delete the unnecessary local account temporarily.

1. After signing in to your computer on an incorrect user profile, start the Windows Run
command option using Wn + R, and enter netplwiz .


https://www.maketecheasier.com/reset-windows-administrator-password/
https://www.maketecheasier.com/reset-windows-administrator-password/
https://www.maketecheasier.com/install-windows11-on-unsupported-pcs/

Typing "netplwiz" command in Run window.

2. You will encounter the Advanced User Accounts Control Panel screen. Enter your
administrator password to proceed. Sometimes there will be an error if the system refuses
to accept your admin password. In that case, use the Windows Safe boot to perform these
steps. (Described in the FAQ below.)

UAC prompt to type administrator password.

3. Click the “Remove” option next to your guest/local account. Even if you're currently
logged in on your computer with the local account, the local profile here will be removed.

Removing local account via User Accounts window.

4. Use Wn + L to exit the local account logon window.

5. Restart the computer, and make sure to use your regular Microsoft account to log back in.

3. Move NTUSER.Dat File to Default
Username Folder

A user profile consists of personalized menu items for desktop, downloads, documents, music,
videos, and saved links that are stored in a folder inside “C:/Users.”

For each of these profiles, a .DAT file called NTUSER.DAT is created by Windows. It contains
personalized user settings. Try moving the file associated with the buggy profile to a default

username folder.

1. Go to the necessary local account inside “C:/Users,” and press Ctrl + Xto cut the
NTUSER.DAT file for that account.

Locating NTUSER.DAT file under Users in "C:/."


https://www.maketecheasier.com/use-windows-without-microsoft-account/

2. Move the .DAT file into the “Default” username folder. You may not be able to see this
folder. If so, change the “View -> Show” to “Hidden items” in File Explorer.

Accessing "View" menu in File Explorer to show hidden files.

3. Delete the local account folder, and restart the PC to see whether the proper user profile

is loading.

Tip: did you know that you can perform a Windows Defender scan from Command Prompt? We
demonstrate how in our guide.

4. Windows User Profile Repair Using
Command Prompt

The evergreen Command Prompt can fix some of the hard disk-related issues that may have
caused the user profile error problem.

1. Go to Start, and search for “Command Prompt.” Select “Run as administrator” under the
result.

Typing "command prompt" via the Start menu.

2. Perform a Deployment Image Servicing and Management Tool (DISM) scan, which helps
repair the Windows image and may solve the user profile services error.

1
DISM.exe /Online /Cleanup-image /scanhealth

Running DISM scan via Command Prompt.


https://www.maketecheasier.com/use-windows-defender-from-command-prompt/

3. Likewise, a System File Checker (SFC) command is the best way to repair corrupt Windows
files, including user profile settings.

1
sfc /scannow

How To Fix User Profile Service Failed Error View Sfc

Tip: the WDF violation error can sometimes arise on your Windows PC. Learn what to do about it.

5. Use Windows Registry Editor in Safe
Mode

The Windows Registry Editor (Regedit) is one of the best solutions to fix the “User profile service
failed the sign-in” error. For this, the troubleshooting is achieved in Safe mode.

1. In Windows 11, go to “Advanced startup” from the Search menu. For Windows 10, the
corresponding option is “Change advanced startup options.”
2. Click “Restart now” to initiate an advanced restart.

Clicking "Restart now" under Advanced startup in Recovery.

3. Select “Troubleshoot” on the blue screen.

Clicking "Troubleshoot" in recovery environment.

4. Go to “Advanced options -> Startup settings,” and initiate another restart of the device.

Clicking on "Startup Settings" via Advanced options.


https://www.maketecheasier.com/fix-wdf_violation-error-windows/

1

Following the restart, you will see a number of startup settings that can be accessed using
the number keys (1-9) or function keys (F1-F9). Select the option to “Enable safe mode.”

Selecting "Enable Safe Mode" option in Startup Settings.

. Once you sign in, you will enter Windows in Safe Mode. Very minimal options are visible in

this mode.

. Start the Windows Run command option using Wn + R, and enter regedit . This task will

be automatically created with administrator privileges.

Typing "regedit" in Run window.

Navigate to the following path in the Registry Editor:

Computer\HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\ProfileList

0.

10.

11.

Check the last few entries under “ProfileList” to see whether there are any duplicates,
e.g., the entries have similar names, but at least one will contain a .BAK file. This
extension will appear at the end of one of the items in the “Name” column. For instance, if
you open one of the ProfileList folders, you may see .BAK after any of the values listed. If
you don’t see anything with this extension, skip to the bottom of the section.

Checking ProfileList key in Registry Editor.

If you do have a value with the extension, and it’s present in the last entry, rename the
.BAK extension to just .BA. For any duplicate entry, rename it to something else, but keep
the .BAK extension. Delete any surplus .BAK extensions, if present, for duplicate entries.
Delete the .BA extension in the entry that was just renamed.

ProfileList keys view in Registry Editor.



12. Right-click and modify the State key of the profile entry from where the .BAK was
removed. Basically, we are switching the active default user profile through a minor
registry tweak.

Modifying key in Registry Editor.

13. Change the hexadecimal DWORD value from a numerical value to “0.” Click “OK"” to save
the settings.

Changing DWORD value via Registry Editor.

14. Restart the PC in normal mode.
15. The “User profile service failed the logon” error should be gone once you log in again.

No .BAK File?

If you don’t have a .BAK file, see the workaround below.
1. Open File Explorer, and navigate to “C:\Users\Default\AppData\Local\Application Data”

2. If you see another folder inside this one named “Application Data,” delete it, and restart
your computer. If you don’t have an Application Data folder at all, this fix will not apply.

FYI: wondering when you should use Command Prompt over Powershell and vice versa? We

highlight the differences.

6. Restart the User Profile Service

Occasionally, third-party software and apps stop the User Profile service from running, resulting in
this error. Restart it using Command Prompt:

1. Open Command Prompt, and run it as an administrator as shown above.
2. Enter the following command, and press Ent er :

1
sc config ProfSvc start= auto


https://www.maketecheasier.com/difference-command-prompt-powershell/

Running command in cmd.

3. At the next prompt, enter the following command, and press Ent er :

1
sc start ProfSvc

Running a "sc start" command in cmd.

4. Restart your computer to fix the error.

5. If these commands won't run, try restarting your PC in Safe Mode, then performing the
above.

6. If another app or program has changed the status of this service, it may continue to stop.
To ensure it starts automatically with Windows, open a Run dialog window, and type

services.msc .

Typing "services.msc" in Run window.

7. Scroll until you see “User Profile Service.”
8. If it doesn’t say “Automatic” under the “Startup Type” column, right-click “User Profile
Service,” and select “Properties.”

Selecting "Properties" for "User Profile Service" in Services app.
9. Change “Startup Type” to “Automatic,” and click “Apply” to save the changes. You may

need to restart your PC to log in correctly.

Setting "Startup type" to "Automatic" in "User Profile Service" properties.

7. Reset Windows PC

If all the above options fail, use the “Reset” option to go back to a clean factory reset of your
Windows operating system. You have to be connected online to achieve this cloud-based reset.



The Windows 11 reset method has been covered in detail, but the essential steps, which are

common with Windows 10, too, are summarized below:

1. Go to “System -> Recovery -> Reset this PC,” and click “Reset PC.”

2. Choose “Keep the files” or “Remove everything.” Choose the former option so that you
don’t need to save a backup. It’s still a good idea to back up your files, just in case
anything goes wrong.

3. Select the “Cloud download” option to reinstall your version of Windows. The download
will take some time to finish.

4. Once you see the “Ready to reset the PC” screen, click “Next” to proceed.

5. Sit back and wait for the reset to finish, as the download will take some time. The entire
procedure can consume anything from a few hours to an entire day, so we recommend
the reset method only if the other methods don’t solve the problem.

Tip: should you opt for a cloud download or local reinstall when performing a Windows reset? We

explain the differences in our post.

Frequently Asked Questions

How do | fix the "User profile failed" error during
sign-in for Windows 8/8.1 and Windows 77

If you're using an older Windows version, such as 8.1/8/7, only a few of the above-described
solutions will be able to address the user profile error. You can try a restart, use a DISM and SFC
scans in Command Prompt, and move the NTUSER.DAT file to a default folder. The options to
delete a local user account and enable a cloud-based reset will not work.

How do | solve the “We can’t sign in to your
account” error while restarting the User profile
service?

Sometimes, while restarting the user profile service in guest/local account mode (Section 6), you're
unable to sign in to your Administrator account. To solve the problem, boot into your Windows
device in Safe Mode, and perform the same steps outlined in section 2. Then, repeat the steps from
Section 6 to restart the User Profile Service.


https://www.maketecheasier.com/reset-reinstall-windows-without-losing-files/#reset-windows
https://www.maketecheasier.com/cloud-download-or-local-reinstall-windows-reset/

Can other software or Windows updates
Interfere with the User Profile Service?

Sometimes it can. If you start getting this error the next time you sign in after installing something
new, try uninstalling the new software to see whether that fixes the problem.

If your PC recently installed updates, try uninstalling them and updating again. Go to “Start,” and
search for “Windows updates.” Select “Update history” and “Uninstall updates” under the list of
recently installed updates. Select what you want to uninstall, and restart your PC.



Windows 11

How to Delete a User Profile on
Windows

The first time a user logs in on a Windows computer, a user profile is created and stored on the
local hard disk. This profile contains all settings, from wallpaper to email details and network
connections. If you've created multiple user profiles on your PC over time, this tutorial shows how
to delete a user profile on Windows that is no longer needed.

1. Advanced System Properties

The easiest way to delete an unnecessary user profile is by accessing the Advanced System
Properties on your Windows PC.

Press Wn + Ron your keyboard to launch the Run dialog, type systempropertiesadvanced in the
box, and click “OK.”
Typing command in Run window.

In the “Advanced” tab, click the “Settings” button under “User Profiles.”

Clicking "Settings" button under "User profiles" in System Properties.

From the list of user profiles stored on your Windows computer, select the one you don’t need, and
click the “Delete” button.
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Click “Yes” in the confirmation dialog that pops up on your screen.

Clicking "Yes"" in "Confirm Delete" pop-up.

The user profile has now been successfully deleted from your computer.


https://wiki.towne.org/uploads/images/gallery/2023-12/image.png

Tip: experiencing issues with the Settings app on Windows? Check out the most effective solutions

for this problem.

2. Settings App

You can also delete a user profile and all of its associated data from your Windows PC by using the
Settings app.

Click the Start button, and launch the Settings app.

Clicking Start menu and selecting the Settings app.

Click “Accounts” in the left pane, scroll down and click “Other users” in the right pane.

Clicking on "Other users" under Accounts in Settings.

You will see a list of other users accessing your computer. Click the arrow next to the user profile
that you want to delete.

Selecting user profile for deletion in Windows Settings.

4. Click the “Remove” button.

Clicking "Remove" button next under specific user profile in Windows.

Click “Delete account and data,” and you’re done.

Pressing on "Delete account and data" button to complete process.

3. Registry Editor

If you prefer, you can also delete a user profile from Windows through the Registry Editor. Make

sure you create a backup of the registry before you proceed, in case something goes wrong during
the process.

Press Wn + Rto launch the Run utility, then type regedit in the box, and click “OK.”


https://www.maketecheasier.com/fix-settings-app-not-working-in-windows-10/
https://www.maketecheasier.com/backup-restore-windows-registry/

Typing "regedit" in Run dialog to launch Registry Editor.

Navigate to the following path on the Registry Editor:

1
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ProfileList

Navigating to location in Registry Editor.

In the left pane, you'll find multiple keys under the ProfileList folder. Click each subfolder one by
one. In the right pane, find the path to the profile you wish to delete in the “Data” field for the
“ProfilelmagePath” key. In this example, we're looking to remove the “vritr” user.

Right-click the ProfilelmagePath key associated with the user profile you are looking to eliminate
and select “Delete.”

Deleting key associated with specific user profile in Registry Editor.

Click “Yes” in the confirmation dialog to remove the user profile from your Windows computer.

Pressing "Yes" on "Confirm Value Delete" window.

4. PowerShell

With PowerShell, you can do all kinds of things, including deleting user profiles, as shown in the
steps below:

Press Wn + X, and click “Terminal(Admin)” to launch PowerShell.

Opening Terminal (Admin) app from WinX menu.

Type the below command, and press Ent er to view the list of user profiles on your computer. Make
a note of the user profile you want to remove from your PC.



1
Get-LocalUser

Typing command in PowerShell.

To delete a specific user profile, use the below command, followed by Ent er . Replace
<userprofilename> with the name of the user profile you want to delete from your Windows
computer.

1
Remove-LocalUser -Name <userprofilename>

Since you won't see a success message for the above command, you can use the same command
in step #2 to verify whether the user profile was deleted.

Inputting commands in PowerShell.

5. File Explorer

You can also delete a user profile and its data on a Windows PC via the File Explorer app, but make
sure you are logged in as an administrator before you attempt to do so.

Press W n + E to launch File Explorer and click “This PC” in the left pane.

Clicking "This PC" in File Explorer.

Double-click “Windows (C:)” under “Devices and drives.”

Double-clicking (C:) to access the drive.

Click on the “Users” folder.

Selecting the "Users" folder in "C:\.""



Select the name of the user profile you wish to delete, and press the Del key on your keyboard to
delete the user profile from your Windows PC.

Selecting user profile for deletion via File Explorer.

FYI: are you frequently encountering problems with the File Explorer app? Check out the most

effective solutions.

Cleaning Up Your Windows PC

While deleting inactive user profiles will not significantly free up storage on your “C:\” drive, learn

additional methods to recover free space. If you’'ve encountered the “User profile service failed the

sign-in” error message, try to delete the user profile and create a new one.


https://www.maketecheasier.com/fix-common-file-explorer-issues-windows/
https://www.maketecheasier.com/recover-free-space-windows-c-drive/
https://www.maketecheasier.com/fix-user-profile-service-failed-the-sign-in-error/
https://www.maketecheasier.com/fix-user-profile-service-failed-the-sign-in-error/

Snap Layouts (screenshot)

Here is a cool feature that is new in Windows 11 that everyone now has on their desktop. It's for
snap layouts. It's convenient because you can save the layout you want for certain classes or work
and not have to redo it every time.

Snap Layouts

If you're the kind of person who likes their apps arranged on the desktop just so, you'll likely be
interested in Snap Layouts. With it, you group your open windows into one of a half-dozen pre-built
screen layouts, such as having two apps side by side, each taking up half the screen. Or you might
have one app on the left and two stacked vertically on the right, or four apps in a grid. The hope is
that you’ll be able to find the layout that fits the way you work.

To use Snap Layouts, open the applications you want to be in it, then hover your mouse over an
application’s maximize icon on the upper right of the screen, located between the minimize and
close icons. Choose the layout you want and which position you want the application to be in, and
the app window snaps into that position. Then you can choose from your other open apps to fill in
the rest of the spots in the layout.

winll cheat sheet 10 snap layout

IDG

A Snap Layout in action. (Click image to enlarge it.)

Once all the places in a Snap Layout are filled, that app grouping is saved as a Snap Group that you
can quickly return to later if you've opened other apps or minimized any of the app windows in the
group. Hover your mouse over the taskbar icon of any of the applications in a Snap Group, and
you'll see two small popups — one that’s a thumbnail of what’'s open in the application itself, and
another that shows the Snap Group. Choose the Snap Group icon, and you’ll switch to the whole
group in the layout you set up previously, rather than to the individual application.
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